
 

Eksplorasi Fitur-Fitur Default PowerPoint 

Menyajikan slide dalam sebuah presentasi, selain menarik juga memiliki 

tingkat efisiensi dan efektifitas yang tinggi. Slide mampu menggambarkan 
pola grafik, gambar, rumus-rumus, video, bahkan bisa mewakili penjelasan- 

penjelasan yang dianggap rumit atau sulit dipahami. 

 
PowerPoint juga memungkinkan anda melakukan komunikasi dengan 

software lain, seperti Microsoft Word atau Microsoft Excel. Seseorang bisa 
menyiapkan bahan presentasi melalui Word lalu memolesnya melalui Power 

Point, bisa juga dengan Excel dan menyisipkannya ke PowerPoint. 

 
Beberapa fitur baru yang disematkan di dalamnya. 

 
1. New Template View: 

 
Ketika kita baru menjalankan PowerPoint, ada beberapa tema yang 
menarik. Terdapat 22 tema tepatnya (termasuk Blank Presentation). 
Apabila salah satu tema tersebut dipilih, maka akan ditampilkan juga 

beberapa pilihan warnanya. Apabila dari tema-tema tersebut tidak ada 
yang cocok dengan keinginan Anda, Anda dapat mencari tema-tema 

secara online langsung dari jendela PowerPoint tersebut. 

 
 Menu Recent, yang menampilkan presentasi yang baru Anda buat, 

 Open Other Presentation, jika Anda ingin membuka presentasi yang 
telah lama anda buat. 

 

2. Embed Clipart, Images and Videos from Web: Menemukan clipart 
yang tepat untuk presentasi Kita menjadi lebih mudah dengan fitur 

pencarian clipart terintegrasi. Juga, Gambar dan Video dapat dicari dan 
dimasukkan langsung dari jendela PowerPoint. 

3. Presenter View: Pada tampilan Presenter baru, kita dapat melihat 
preview slide berikutnya, dan catatan presenter kita. Para audiens hanya 
melihat slide ini kita memberikan presentasi. Ada juga fitur zoom baru 

yang memungkinkan kita memperbesar dan dari diagram, tabel dan grafik 
saat memberikan presentasi. 

 
A. Penyiapan Materi 

Konsep materi atau isi presentasi sebelumnya perlu dipersiapkan untuk 

memudahkan kita dalam membuat presentasi dengan program MS-Office 

PowerPoint. Pada bagian ini Anda perlu memperhitungkan waktu yang 

tersedia untuk menyampaikan presentasi, siapa yang akan mendengarkan 

dan menyaksikan presentasi serta untuk tujuan apa Anda melakukan



presentasi. Untuk bagian ini Anda sebagai pembuat konsep presentasi lebih 

mengetahui apa yang akan disajikan. 

 
B. Merancang dan Membuat Presentasi 

Merancang dan membuat presentasi yang baik dengan menggunakan 

program MS-Office PowerPoint sesungguhnya sangat tergantung kepada 

kreatifitas dan citra seni kita. Fasilitas yang disediakan begitu banyak 

sehingga begitu beragam bentuk yang dapat dibuat. Dapat dikatakan bahwa 

kita dapat membuat karya yang sangat beragam dan indah, bergantung dari 

kemauan dan kreatifitas kita. 

Cara yang terbaik untuk membuat presentasi multimedia adalah dengan 

mencoba berbagai fasilitas yang ada. 

 
1. Membuat presentasi 

 Setelah anda masuk ke lembar kerja slide, Anda bisa langsung 

membuat presentasi. 

 Slide pertama adalah slide blank presentasi dengan format layout 

untuk Judul presentasi. Anda ketikkan langsung saja Judul dan Sub 

Judul. Misalnya kita akan buat slide tentang Pengenalan Mirosoft Office 

maka tampilan slide pertama seperti pada contoh. 

 

 

Gambar lembar kerja slide 

 
 

2. Menambah slide baru 

Ketika Anda menyisipkan slide baru, biasanya akan memiliki penampung. 
Penampung dapat berisi berbagai jenis konten, termasuk teks, gambar, dan 

banyak lagi. Beberapa penampung memiliki teks placeholder, yang dapat 
Anda ganti dengan teks Anda sendiri. Lainnya memiliki ikon thumbnail yang 



kali Anda membuat slide baru, Anda 

harus memilih tata letak slide yang 

sesuai konten Anda. 

Anda sertakan. Setiap 

informasi pada jenis 

penampung, untuk berbeda 

tergantung 

yang  ingin 

Slide memiliki beberapa layout yang 

2. Pilih Slide Layout dari menu 

yang muncul pada Office Theme. 

memungkinkan Anda untuk menyisipkan gambar, grafik, video dan banyak 
lagi. 

 

Slide placeholder kosong 
 

Layout slide yang berbeda 

 

3. Menyisipkan Slide Baru 

Setiap kali Anda memulai presentasi baru, maka akan berisi satu slide 

dengan layout Slide Judul. Anda dapat memasukkan sebanyak slides yang 

anda butuhkan dari berbagai layout yang berbeda. 

1. Klik tab Home, pilih dan klik tools New Slide pada group tools Slides. 

 



3. Slide baru akan muncul. Klik placeholder mulai mengetik untuk 

menambahkan text. Anda juga dapat meng-klik icon untuk 

menambahkan content lainnya, misalnya gambar atau grafik. 

 

 

 

Memilih layout slide Slide baru 

 

4. Untuk mengubah tata letak slide yang ada, klik perintah Layout 

kemudian pilih layout yang dikehendaki. 

 

 

Slide baru Meletakkan layout baru pada slide yang ada 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4. Menyisipkan slide baru dalam satu layout 

 

  
 
 

C. Pengaturan Slide 

Anda dapat menambah, menghapus, serta menduplikasi slide dengan 

langkah sebagai berikut: 

a) Klik kanan slide yang akan di atur. 

b) Maka akan tampil menu seperti dibawah ini. 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 
 

 

 

 

Untuk menambahkan slide yang 
menggunakan tata letak yang sama 
dengan slide yang dipilih dengan cepat, 

cukup klik bagian atas perintah New 

Slide. 

Menyisipkan Slide 

Bila anda ingin menambahkan slide baru, 

tetapi bukan sebagai slide terakhir, anda 

dapat memilih slide yang terletak tepat 

sebelum     slide      baru      disisipkan. 

Klik ikon slide. 

1. Klik Insert 

2. New Slide 

3. Pilih Layout Slide yang dinginkan 

Menduplikasi Slide 

Untuk menduplikasi suatu slide, misalnya 

ingin membuat dua buah slide yang 

tampilannya serupa, tetapi isinya berbeda. 

1. Klik pada ikon slide, klik kanan mouse 

2. Pilih menu Edit lalu klik Duplicate. 

Menghapus Slide 

Penghapusan slide dapat dilakukan dengan 

berbagai cara. 

1. Klik ikon slide, klik kanan mouse. 

2. Tekan tombol Delete maka Slide akan 

terhapus dari file .ppt. 



a. Melakukan Editing Sederhana 
i. Font (Huruf) 

Cara mengatur Font 



 Klik Judul Slide, kemudian blok teks yang ada dalam judul teks

 

 Klik Menu Home dan pilih font

 Klik kotak dialog maka akan tampil perintah seperti gambar dibawah ini;

 

 Setelah dilakukan pengaturan klik tombol OK

 

ii. Alignment 

Untuk pengaturan tulisan dapat dilakukan dengan memilih format > 

alignment right , left (ctrl+l) memberikan efek tulisan rata kiri seperti 
gambar di bawah ini. 

 

  



iii. Bullet and Numbering 

Anda dapat menambahkan perintah penandaan paragraph, dengan memilih 

tool Bullet atau Numbering. 

 
Cara mengatur Bullet atau Numbering 
 Blok teks yang akan diberi bullet atau numbering

 Klik tool Bullet atau Numbering seperti dibawah ini

 

Pilihan Bullet Pilihan Numbering 

 
 Pilih Bullet atau Numbering yang diinginkan 

 
iv. Menyisipkan Teks 

Untuk menambahkan teks pada lembar kerja presentasi yang masih kosong, 

anda dapat menggunakan menu INSERT. 

Langkah yang dilakukan sebagai berikut: 

 Klik menu Insert kemudian pilih Shapes






 Klik tool Text Box, kemudian letakkan posisi kursor pada tempat yang 

diinginkan.

 Kemudian akan tampil tanda seperti gambar dibawah ini.

 Yang berkedip dan diikuti dengan bingkai sebagai tempat penulisan teks.

 Kemudian anda dapat mulai mengetik teks.

 



v. Menambah obyek 

Anda dapat menambahkan obyek dalam tampilan sebuah slide, seperti 

bintang, tanda panah dan lainnya. 

 

1. Cara membuat obyek adalah: 

 Klik menu Insert > Shapes

 

 
 

 

 

 

 

 
 

 

 
 

 

 
 

 

 

2. Meng-edit obyek 
Klik kanan pada obyek yang akan di edit, maka akan tampil menu perintah untuk 

melakukan pengaturan.

memilih obyek tersebut. 

 Tempatkan kursor pada layar 
slide, yang akan berubah seperti 

tanda +. 
 Lakukan dengan cara drag agar 

obyek akan tampil 

shapes 

dapat tampil, maka anda 
 Setelah obyek pilihan 

b. Jika anda akan 

menggunakan style 



c. Anda dapat 

menggunakan 
Fill. 

 
d. Atau anda 

dapat pula 

menggunakan 

Outline 

 

 

 
D. Menampilkan Slide 

Setelah slide presentasi Anda selesai dibuat, kemudian bagaimana anda 

dapat menyampaikan presentasi kepada para audiens. PowerPoint 

menawarkan beberapa perangkat dan fitur untuk membantu membuat 

presentasi Anda halus, menarik dan profesional. 

 
Cara Memulai menampilkan Slide Show 

1. Klik  Start  From   Beginning   dari   perintah   awal   pada Quick 

Access Toolbar atau tekan tombol F5 di bagian atas keyboard Anda. 
Presentasi akan muncul dalam modus layar penuh. 

 

 
 

2. Klik tool Start From Beginning command 

 
Anda juga dapat mengklik Play Slide Show perintah di bagian bawah 

jendela PowerPoint untuk memulai presentasi dari slide ini. 
 



3. Tab Menu Slide Show 
 

 Klik tab Slide Show pada Ribbon untuk mengakses lebih banyak pilihan. 

Dari sini, Anda bisa memulai presentasi dari slide yang sekarang dan 
mengakses pilihan Advanced Presentation.

 

 

 From Beginning : menampilkan presentasi dimulai dari slide pertama.

 From Current Slide : menampilkan presentasi dimulai dari slide yang 

sedang aktif.

 

 Setelah tampil dalam presentasi, maka anda dapat menggunakan tombol- 
tombol untuk memindahkan posisi slide.

 
4. Cara Menampilkan Advance dan Reverse Slides 

 Anda dapat maju ke slide berikutnya dengan mengklik mouse atau 

menekan Space Bar pada keyboard Anda. Atau dapat menggunakan 
tombol panah pada keyboard Anda untuk bergerak maju atau mundur 
melalui presentasi.

 Anda juga dapat hover mouse Anda ke bagian bawah - kiri dan klik panah 
untuk bergerak maju atau mundur.






Clicking the arrow to advance a slide



5. Cara Menghentikan Slide Show 

 Anda dapat keluar dari mode presentasi dengan mengklik tombol Esc pada 

keyboard Anda. Atau dapat mengklik tombol Slide Show Options di bawah 
kiri dan kemudian pilih End Show.

 Presentasi ini juga akan berakhir setelah slide terakhir . Anda dapat 

mengklik mouse atau tekan Space Bar untuk kembali ke tampilan normal.
 

 

Ending a slide show Clicking to exit 



Fitur Mempercantik Slide pada PowerPoint 

 

A. Mempercantik Presentasi dengan Animation Effects 
 

Ketika Anda bekerja dengan efek animasi ganda untuk satu objek atau slide, 

kami sarankan menggunakan Pane Animasi. 

Klik Animation > Advanced Animation > Animation Pane untuk 

membuka. 

 
1. Klik teks, gambar atau obyek yang akan ditambahkan animasi efeknya. 

2. Klik tab Animations, maka tampil galeri Animasi atau Add Animation. 

 

 
3. Klik Add Animation untuk menambahkan efek lain. Jika Anda tidak 

menggunakan Add Animation, Anda tidak akan menambahkan efek baru 

melainkan akan mengubah efek yang telah diterapkan. 

4. Gunakan Animation Pane untuk mengubah urutan efek. 
 
 

 
 
 
 

 



  
 

5. Pilih kelompok Timing pada tab Animation untuk mengkoordinasikan 

ketika setiap efek dimulai dan berapa lama berlangsung. 

6. Pada Start, pilih With Previous untuk menjalankan efek pada saat yang 

sama seperti yang lain. Pilih After Previous untuk memulai efek ketika 

satu lagi selesai. 

7. Untuk melihat bagaimana semuanya bekerja bersama-sama, klik Preview 

pada tab Animation. 

 

 
B. Menggerakkan Objek dengan Motion Path 

 
Gambar, teks atau obyek dapat ditambahkan jalur gerak. Pusat dari objek 

atau teks mengikuti jalur gerak yang Anda terapkan. 

 
1. Pada tab Animations, klik tombol More di Galeri Animasi kemudian pilih 

dan klik Motion Paths 

 



 Pilih Lines, Arcs, Turns, Shapes atau Loops. Path yang dipilih muncul 

sebagai  garis  putus-putus  pada  objek  atau  teks  yang  dipilih.   

Panah hijau menunjukkan awal jalan dan panah merah menunjukkan 

ujungnya. Tarik kedua ujung untuk menempatkan titik akhir di mana 

Anda inginkan. 

 Klik Custom Path, dimana Anda dapat mengatur jalur gerak untuk 

memulai maka pointer akan berubah menjadi . 

 Klik To draw a path of connected straight lines, di mana Anda dapat 

untuk memulai mengatur jalur gerak. Klik dan pindahkan pointer, untuk 

membuat garis antara dua titik. Pindahkan dan klik lagi untuk menarik 

garis yang lain. Klik dua kali untuk menghentikan menggambar garis. 

 Klik To draw a freehand path, perintah untuk memulai mengatur 

gerakan. Agar obyek dapat mengikuti jalur gerak, maka klik dan tahan 

tombol kiri mouse untuk memindahkan pointer pada jalur yang Anda 

inginkan. Klik dua kali pada titik akhir gerakan itu. 

 
3.  Untuk   melihat   bagaimana   semuanya   bekerja   bersama-sama,   klik 

Preview pada tab Animation. 

 
C. Menambah obyek dan memberi Efek 

 
Mari kita menambahkan efek untuk sebuah obyek bentuk bintang kedalam 

tampilan seperti ritsleting di slide, dengan menambah goyangan sedikit 

sebelum slide jatuh, seolah-olah itu jatuh dari meja. 

Langkah yang dilakukan sebagai berikut: 

 
1. Membuat obyek bintang dengan cara klik Insert > Shapes, dan dibawah 

Stars and Banners, klik sebuah bentuk bintang. 

 

 
2. Klik slide di mana bintang akan ditempatkan, lakukan dengan cara drag 

untuk menarik bintang. 



3. Langkah berikut adalah memberikan efek, kemudian klik tab Animations 

pilih dan klik Fly In dibawah Entrance pada galeri Animation. 

4. Klik Effect Options > From Left. Pada kelompok Timing, atur Duration 

pada 01:50. 

5. Klik Add Animation kemudian pilih dan klik Fade dibawah Entrance. 

Pada kelompok Timing atur Start to With Previous (sehingga ia pergi 

pada saat yang sama dengan efek Fly), dan Duration pada 01:00. 

 

 

6.  Klik Add Animation kemudian pilih dan klik Teeter dibawah Emphasis. 

Pada kelompok Timing atur Start to After Previous (sehingga mulai 

segera setelah efek masuk dilakukan). Perhatikan Animation Pane  

bahwa efek Teeter (kuning) sejajar setelah efek masuk (hijau). 

 

 



9. Langkah terakhir: 

klik Add Animation, 

dibawah Emphasis, 

klik Spin, kemudian 

klik Effect Options > 

Clockwise, lalu klik 

Effect Options > Half 

Spin. pada group 

Timing, atur start to 

With Previous. 

7. Klik Add Animation kemudian pilih dan klik Pulse dibawah Emphasis. 

Pada group Timing atur Start to With Previous (sehingga berjalan 

bersama-sama dengan efek Teeter). 

8. Klik Add Animation dibawah Motion Paths, klik Arc, kemudian klik 

Effect Options > Right. Pada kelompok Timing, atur Start to After 

Previous, dan atur Duration sampai 01:00. Tarik titik akhir (panah 

merah) sehingga bintang berjalan dengan baik di bawah bagian bawah 

slide. 

 

 

 

 

 
 

10.Pada tab Animations, klik Preview. 



D. Mengenal Theme 
 

Theme adalah kombinasi standar dari warna, font, dan efek. Tema yang 

berbeda juga menggunakan layout slide yang berbeda. Anda dapat memilih 

dari berbagai tema baru setiap saat, memberikan seluruh presentasi Anda 

yang konsisten, terlihat profesional. 

 

a) Menggunakan Template 

Pemberian latar belakang pada semua slide dapat dilakukan dengan mudah, 

yaitu dengan menerapkan template. Anda bisa memilih salah satu dari 

template yang disediakan oleh PowerPoint. 

Ikuti langkah-langkah berikut: 

1. Klik menu Design, kemudian pada panel theme pilih salah satu design 

yang kita inginkan. Untuk melihat pilihan design lainnya klik vertikal 

scrollbar sebelah kanan pada panel theme. Berikut adalah tampilan panel 

theme. 

 

Gambar pilihan Themes 

 

2. Pilihlah template yang anda kehendaki misalnya Oriel. 

 
b) Mengatur Skema Colors, Fonts, Effects dan Background Style 

Pada Slide 

1. Colors 

Anda dapat mencampur dan mencocokkan warna, font, dan efek untuk 

membuat tampilan yang unik untuk presentasi Anda. Jika masih tidak terlihat 

tepat, Anda dapat menyesuaikan tema cara apapun yang Anda inginkan. 

 

Warna background yang telah anda pilih bisa diganti dengan cara: 

 Klik tombol More pada menu Variants 



 Klik tombol More 

pada menu Variants. 

 Klik dan pilih Fonts 

 

 Klik Colors kemudian pilih komposisi warna yang diinginkan. 

2. Fonts 

Untuk merubah format text dapat juga menggunakan pilihan font. Langkah 

yang dilakukan adalah: 

 

 
 

3. Effects 

Anda dapat menambahkan effect yang sama pada semua slide, langkah yang 

dapat dilakukan adalah: 

 Klik tombol More pada menu Variants 

 Klik dan pilih Effects 



Memberikan dan menentukan style 

untuk latar belakang slide dapat 
dilakukan dengan langkah: 
 Klik tombol More pada menu Variants. 
 Klik dan pilih Background Style. 

 Pilih format Background Style untuk 

menambahkan perintah Fill. 

Lakukan hal berikut: 

 
1. Klik tab Design, kemudian klik 

Slide Size. 

2. Klik Widescreen (16:9). 

 
 
 

4. Background Style 

 
E. Mengefektifkan Slide dengan Fitur Pengatur Ukuran slide Powerpoint 

Banyak dari TV dunia dan video telah pindah ke format layar lebar dan HD, 

dan sebagainya memiliki PowerPoint. Ukuran slide standar sekarang 

widescreen (16:9). Berikut adalah bagaimana Anda dapat mengubah ukuran 

slide: 

 
a) Mengubah ukuran slide dari standar ke layar lebar. 

 

 

b) Mengubah ukuran slide dari layar lebar ke standar. 

 
Anda dapat lakukan hal berikut ini: 

a. Klik tab Design, kemudian klik Slide Size. 

b. Klik Standard (4:3)

http://ppt2013tip.blogspot.com/2012/12/mengatur-ukuran-slide-powerpoint-2013.html


 

c) Mengatur rasio aspek 4:3 sebagai ukuran standar. 

Jika Anda ingin terus menggunakan rasio aspek 4:3, Anda dapat 

mengaturnya sebagai ukuran slide default. Berikut ini langkah-langkah yang 

dapat dilakukan: 

 
1. Dengan rasio aspek 4:3 diterapkan pada slide Anda, pada tab Design, 

pada group Themes, klik More , kemudian Save Current Theme. 
 

2. Pada kotak File name, masukkan nama dari theme, kemudian klik Save. 
3. Klik kanan dan simpan theme, kemudian pilih Set as Default Theme. 

 

 

 

14.6 Transitions 

PowerPoint menyiapkan sebuah presentasi dengan memberikan "efek 

khusus" antara setiap slide, maka Anda telah melihat transisi slide. Transisi 
dapat sesederhana memudar ke slide berikutnya, atau dapat menjadi 
mencolok, efek eye-catching. PowerPoint memudahkan untuk menerapkan 

transisi ke beberapa atau semua slide Anda, memberikan presentasi dipoles, 
terlihat profesional. 

 
a) Jenis Transisi 

Ada tiga jenis transisi yang unik untuk memilih dari, yang semuanya dapat 
ditemukan pada tab Transition: 

 



a) Pilih slide yang diinginkan dari 

panel Navigasi Slide. Ini adalah 

slide yang akan muncul setelah 
transisi. 

b) Klik tab Transisi, kemudian cari 

Transisi ke grup ini Slide. 
Secara default, akan diterapkan 

untuk setiap slide. 

a) Subtle 

Adalah jenis yang paling dasar dari transisi. Mereka menggunakan animasi sederhana 
untuk memindahkan antara slide. 
 

 
 

b) Exciting 

Ini menggunakan animasi lebih kompleks untuk transisi antara slide. 
Sementara mereka lebih visual menarik daripada transisi Subtle, 
menambahkan terlalu banyak dapat membuat presentasi Anda terlihat 

kurang profesional. Namun, ketika digunakan dalam moderasi, mereka dapat 
menambahkan sentuhan yang bagus antara slide penting.. 

 

c) Dynamic Content 

Jika Anda mengalihkan antara dua  slide  yang  menggunakan  slide  
layout yang sama, transisi dinamis akan bergerak hanya sebagai 
penampung, bukan slide sendiri. Ketika digunakan dengan benar, transisi 

dinamis dapat membantu untuk menyatukan slide Anda. 
 

 
b) Cara Melakukan Transition: 

 

Menentukan slide 



c) Klik panah drop-down untuk menampilkan semua transisi. 

 

Klik tombol drop-down arrow 

 

d) Klik transisi untuk menerapkannya ke slide yang dipilih. Ini akan 

otomatis melihat transisi. 
 

 

Memilih transisi 
 

Anda dapat melakukan untuk semua perintah dalam kelompok Timing untuk 
melakukan transisi yang sama untuk semua slide dalam presentasi Anda. 

Perlu diingat bahwa ini akan memodifikasi transisi lain yang telah dilakukan. 
 

Menambahkan transisi yang sama untuk semua slide 
 

Cobalah untuk melakukan beberapa jenis transisi ke berbagai slide dalam 

presentasi Anda. Anda mungkin menemukan bahwa beberapa transisi 
bekerja lebih baik daripada yang lain, tergantung pada isi slide Anda. 

 
d) Menampilkan Transisi: 

Anda dapat melihat transisi untuk slide yang dipilih setiap saat,menggunakan 

salah satu dari dua metode: 
 Klik perintah Preview pada tab Transisi.



 

Klik tombol Preview 
 

 Klik perintah Play Animations di panel Navigasi Slide.
 

 
14.7 Menambahkan catatan 

 
Slide akan sangat baik jika Anda tidak memberikan terlalu banyak informasi. 
Anda bisa menambahkan fakta dan catatan dalam catatan pembicaraan, dan 
jadikan rujukan Anda saat menjalankan presentasi. 

 

a) Untuk membuka panel catatan, pada bagian bawah jendela klik tombol 

Note 

 

 

b) Klik di dalam panel Note dibawah slide tersebut, dan ketikkan catatan 

Anda. 
 

 


